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5
Variables and Commands in Scripts

In scripts, you can access VBS variables and DIAdem variables.

DIAdem has a large number of variables, for example, for configuring functions or commands. 
You do not need to be familiar with these variables and commands to use the DIAdem 
environment, but when you automate DIAdem with a script, calculate formulas, or create reports, 
these variables give you more options.

This lesson introduces the DIAdem variable types, the value ranges of the DIAdem variables, and 
the context in which you use the variables. You will also learn about the most important DIAdem 
commands and command parameters and how to define and use your own commands.

Topics

A. DIAdem Variables

B. DIAdem Commands in Scripts

C. Selected DIAdem Commands

D. Defining and Using User Commands
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A. DIAdem Variables
A variable has a value that you can modify.

Every variable has a certain type. The variable type determines the type and the value range of the 
variable.

DIAdem uses a wide range of variables, most of which you can access via the program interface. 
You can use interface variables in scripts or to label REPORT layouts and VIEW layouts.

DIAdem has two types of variables:

• Function-related variables
These variables are command specific. DIAdem uses these program variables to store results 
or to configure functions.

• Freely-usable variables
These variables are not assigned to specific functions in DIAdem. The variables include 
auxiliary variables, which DIAdem provides, and the user variables, which you specify 
yourself.

Setting the Variable Dimensions
A variable is a single value, a vector, or a matrix.

Scalar Variables
Scalar variables represent one value.

Example SmoothWidth

This scalar variable is a parameter of the smoothing function. The SmoothWidth variable 
specifies the one-sided smoothing width.

Vector Variables
Vector variables represent a one-dimensional array. You can access several values with the variable 
name and the array index.

Example ChnName(5)

Every Data Portal channel has its own name, which you access with the ChnName(i) vector. The 
example accesses the name of the fifth channel in the Data Portal.

Note Unlike VBS variables, the lower limit of most DIAdem vector variables is one, 
not zero. Sa

m
pl

e



DIAdem Advanced Course Manual

© National Instruments Ireland Resources Limited | 5-3

Matrix Variables
Matrix variables are two-dimensional arrays. These variables can also access several values with 
the variable name and the array indexes.

Example ChD(4,10)

The ChD(Row,Channel) variable is the two-dimensional variable that is the basis for the internal 
data store. Use the indexes to access the fourth value of the tenth channel in the Data Portal.

Variable Types
Table 5-1 lists the individual variable types and their value ranges.

Note When you define calculation formulas in scripts or in the Calculator, as shown, 
use only operand types that are compatible with each other.

Correct R1 = 3.14

SmoothWidth = 17

Ch("Result") = sin(Ch("X"))

Table 5-1.  Variable Types and Value Ranges

Type Value Range Example

Boolean 0 or 1 and
“Yes” or “No”

1

Byte 0 ... 255 32

Word 0 ... 65535 40200

Integer -32768 ... 32767 -3

LongInteger -2147483648 ... 2147483647 135000

Real (Double) -1.79769313486232E308 to 
-4.94065645841247E-324 for 
negative values 
4.94065645841247E-324 to 
1.79769313486232E308 for 
positive values

7.668

Dynamic enumeration list Unlimited number of characters “gear”

Free Text (String) Unlimited number of characters “any text”

Enumeration Keyword list Colors: red, yellow, green, 
blueSa
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Incorrect R1 = sin(Ch("X"))

SmoothWidth = 17.34

Ch("Result") = PI

You can only assign a single value to a variable and you only can assign channel references to 
channels. You must convert floating-point numbers before you assign the numbers to integer 
variables.

Program Variables
Program variables are variables which you use to configure functions and which you specify in 
dialog boxes.

Use the variable name to access a program variable. The variable reference in the DIAdem Help 
provides an overview of all available program variables and their functions. Press <Ctrl-Shift-C> 
to copy a list of the variables used in the current dialog box either to the clipboard, or straight to 
the script if you are in recording mode.

You can also use the dialog box Help to search for a variable name. Open the dialog box and click 
Help. The dialog box Help explains what each parameter in the current dialog box means. Related 
topics are also listed.

Note When you use program variables in scripts, remember that many of these 
variables belong to a parent object. You must access these variables via their respective 
object hierarchy.

Accessing Data and Descriptive Information
You frequently use the variables listed in Tables 5-2 to 5-6 in the Calculator and to create scripts. 
These variables contain information about channel properties or show the current date and time.

Table 5-2.  Channel Properties

Variable Name Meaning

Ch(Name) Data from the Name channel

CC(Name)
ChnComment(Name)

Comment from the Name channel

CL(Name)
ChnLength(Name)

Length of the Name channel

CD(Name)
ChnDim(Name)

Unit of the Name channel

CMin(Name) Minimum value of the Name channel

CMax(Name) Maximum value of the Name channel
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ChD(Row,Name)
ChDx(Row,Name)

Value of the Name channel in the row Row

ChT(Row,Name) Contents of the Name text channel in the row Row

ChDWfX(Row, Name) X part of the Name waveform channel in the row Row

Table 5-3.  Files and Folders

Variable Name Meaning

AutoFile Name of the current script

SchemeFile Name of the current block diagram

DataFile Name of the current data file

PicFile Name of the current report

ScriptReadPath / 
ScriptWritePath

User folder for scripts

DataReadPath / 
DataWritePath

User folder for data files

LayoutReadPath / 
LayoutWritePath

User folder for layouts

CurrentScriptName Name of the current script, the current dialog box file, or the 
current user commands file

CurrentScriptPath Folder of the current script, the current dialog box file, or the 
current user commands file

Table 5-2.  Channel Properties (Continued)

Variable Name Meaning
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Controlling Program Behavior
Table 5-6 describes Boolean variables in scripts. 

Table 5-4.  Date and Time

Variable Name Meaning

CurrDate Current date

CurrTime Current time

CurrDateTime Current date/time

CurrDateTimeReal Current date/time in seconds

Table 5-5.  Status Monitoring

Variable Name Meaning

MsgState Status in which a message box was closed

DlgState Status in which a dialog box was closed

Table 5-6.  Program Control

Variable Name Meaning

AutoAbort Enables/disables <Esc> to abort the script

AutoEcho Enables/disables messages in the status bar

ChnNameOver Calculations overwrite/do not overwrite existing channel 
names

ChnCommentOver Calculations overwrite/do not overwrite channel comments

SoundActive Enables/disables acoustic signal output
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Auxiliary Variables
Auxiliary variables are not connected to any function in DIAdem. You can assign these variables 
freely. Table 5-7 lists names, dimensions, and the type of the auxiliary variables.

You can view and change the available custom variables in the extended mode of the Calculator.

DIAdem also provides auxiliary variables that have the data type Variant (O1...O10). You can 
use these variables only in scripts, not in the Calculator.

Note Do not use a DIAdem auxiliary variable as a counter in a For loop. Use the VBS 
variables instead.

User Variables
DIAdem allows you to add your own variables to the existing collection of variables.

Select File»New»User Variables to define these variables in a user variable file (*.vas). When 
you load a VAS file, you add the user variables to the current variable collection. You can then use 
these new variables freely.

Refer to Appendix B, User-Defined Variables, for more information and examples on working 
with user variables.

Table 5-7.  Auxiliary Variables

Type Variable Name Value Range Example

LongInteger L1, L2, ..., L30 Single value L3= 12345

LV1, LV2, LV3 Vector[1...15] LV2(2) = -235

Real R1, R2, ..., R30 Single value R2= 0.12345

RV1, RV2, RV3 Vector[1...15] RV3(1) = 12.35

Boolean B1, B2, ..., B10 Single value B5= Yes

Text T1, T2,..., T10 Single value T4 = "Mo_12"

TV Vector[1..0.10] TV(7) = "XY"

Dynamic 
enumeration list

G1, G2, ..., G10 Single value G1= "Gear"

GV Vector[1...10] GV(1)= "Engine"
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VBS Variables
In addition to the DIAdem program variables, auxiliary variables, and user variables, you can also 
use VBS variables in scripts.

Use the Dim statement to declare VBS variables in a script as described in the Variables section of 
Lesson 2, The VBS Functionality. These variables have a local scope. This means that only the 
script or procedure, for which you declare the variables, recognizes the variables. However, you 
can also use DIAdem commands to declare global variables.

Global VBS Variables
Global variables are valid and retain their contents as long as DIAdem is running and you do not 
restart the script engine.

Use the following command to declare global variables:

Syntax GlobalDim("Variable name")

Example Call GlobalDim("MyVar, MyArray(10)")

The example declares the scalar variable MyVar and the array variable MyArray as global 
variables.

Note If the name of a VBS variable is the same as the name of a DIAdem variable, the 
VBS variable replaces the DIAdem variable. You must then use Diadem.Variable to 
call the original DIAdem variable.

Use the following command to give global dynamic arrays a new dimension:

Syntax GlobalReDim("Variable name")

Example Call GlobalDim("MyArray()")
Call GlobalReDim("MyArray(10)")

First the example declares the dynamic array MyArray. This array can change size while the script 
runs. The GlobalRedim command then specifies the number of dimensions and their size. 
Because arrays are zero-based in VBS, a one-dimensional array with 11 elements is created here.

You can access global variables in all DIAdem panels, in scripts, in dialog boxes, and in user dialog 
boxes. Use the syntax @@MyVar@@, for example, to display the contents of the global variable 
MyVar in a text in the report.

Note To delete global variables, restart the script engine with the ScriptCmdReset 
command. Sa
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DIAdem Script Variables
In scripts you use variables to call functions, to configure commands, to write loops, to create 
dialog boxes, and more. You can access all DIAdem variables in scripts.

When you use DIAdem variables in scripts, ensure that DIAdem does not simultaneously use these 
variables internally and that the object environment is available if necessary. Otherwise, the 
program might not run properly, or might even crash.

To avoid this, you have freely assignable variables that DIAdem does not use.

B. DIAdem Commands in Scripts
Commands execute internal functions. Most of these functions require settings, which you provide 
in a parameter list. You call commands with Call.

Basic Structure of a DIAdem Command
The command name consists of the object the command relates to, and the action the command 
executes. For example, ChnSmooth smoothes a channel: Chn stands for channel and Smooth for 
the smoothing function.

Figure 5-1 shows the structure of a DIAdem command. The parameter list is optional. That means, 
if you want to execute a command, you do not have to enter all the parameters.

Syntax
Figure 5-1.  Basic Structure of a DIAdem Command

Examples The syntax of the ChnSmooth command is shown and 
explained in the following example.

(1) Call ChnSmooth("X","Res",SmoothWidth,SmoothType)

(2) Call ChnSmooth("X","Res")

(3) Call ChnSmooth("X",,L1)

(4) Call ChnSmooth

Examples 1-3 smooth channel X with the smoothing width specified in SmoothWidth (1) and 
L1 (3). If you do not enter the smoothing width (2), DIAdem uses the current contents of the 
SmoothWidth variable. The same applies for the smoothing type and the variable SmoothType 
(2-3). DIAdem saves the calculation results of (1) and (2) in channel Res. If result channel (3) is 
not specified, DIAdem creates a new result channel in the Data Portal.

To avoid uncontrolled script behavior, do not omit the parameter list (4). This command call uses 
any channel for smoothing.

Command Action Command Object Opt. Parameter List 

Command (Optional Parameter List) 

Name Syntax 

Sa
m

pl
e



Lesson 5 Variables and Commands in Scripts

5-10 | ni.com

Some commands do not require parameters, for example, waiting for a keystroke:
Call KeyWait

Calling a Command
Table 5-8 shows the different ways to call a command.

Frequently Used DIAdem Commands
When DIAdem generates scripts in recording mode, DIAdem stores only the commands that 
reproduce the results. DIAdem suppresses non-essential commands, such as dialog box display and 
panel changes. You can enter commands manually to make the script much more effective.

Table 5-9 shows a selection of important script commands. Refer to the DIAdem Help for a 
complete list of commands.

You can easily integrate these commands into your scripts. If you idle the cursor over a command 
in the script editor, the SmartInfo displays a short description and the parameter list. If you can 
configure a command, DIAdem displays the SmartInfo for the first parameter, after you enter the 
opening parenthesis. DIAdem automatically displays SmartInfos on further parameters after you 
enter a comma. Press <F1> to branch into the context Help for a detailed description of the 
command.

Table 5-8.  Command Calls

Commands without Parameters Commands with Parameters

KeyWait ChnSmooth 2,3,25

KeyWait() Call ChnSmooth(2,3,25)

Call KeyWait()

Table 5-9.  Important Commands

Command Purpose

ChnAlloc Allocates and names channels

Calculate Calculates a user-defined function

DirLstWrite Creates a list file

ExtProgram Calls an external program

FileX Checks whether a file exists

FileDlgShow Displays the standard dialog box for entering file names

GlobalDim Declares global variables
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C. Selected DIAdem Commands

Standard Dialog Box for Selecting Files
The file selection dialog box opens whenever you load, save, or search for data files or information 
files. In this file selection dialog box, you select or change the name and the folder of the file that 
you want to load or to save.

InteractionOn Interrupts a script

KeyWait Script waits for next keystroke

MsgBoxDisp Displays a user message in a message box

MsgBoxSetPos Positions / scales message box

MsgButtonTextSet Defines button labels

PathDlgShow Opens the standard dialog box for path selection

Pause Stops a script

ScriptCmdAdd Registers a script that contains user commands

ScriptInclude Integrates a script

SubSequence Starts a script only as an Include script

SudDlgShow Displays a scriptable user dialog box

TextFileClose Closes a text file

TextFileEOF Checks the end of a text file

TextFileOpen Opens a text file

TextFileReadLn Reads a line from a text file

TextFileSeek Jumps to a line in a text file

TextFileWriteLn Writes a line in a text file

UserVarCompile Activates a user variable file

WndShow Opens and closes a DIAdem panel

Table 5-9.  Important Commands (Continued)

Command Purpose
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You can also use the standard dialog box in scripts for file selection, for example, the Open 
REPORT Layout dialog box from the REPORT panel, shown in Figure 5-2.

Figure 5-2.  Standard Dialog Box for Selecting Files

In a script, you open the dialog box for entering a filename with the following command:

Syntax ReturnValue =FileDlgShow(FileDlgName,
             [FileDlgFilt], [FileDlgCaption],
             [FileDlgMultiSelect])

You must enter the first parameter; the other parameters are optional.

The meanings of the parameters are explained as follows:

FileDlgName Specifies a file. You can also specify the path and the filename extension.

FileDlgFilt Specifies which type a file is. The specification comprises the name and the 
actual filter, separated by a comma, for example, "Text 
(*.txt),*.txt". If no name is specified, DIAdem uses a default 
description. To use several filters simultaneously, use | to separate the 
filters: "Text(*.txt),*.txt| List(*.lst),*.lst"

FileDlgCaption Specifies the dialog box heading. If you do not enter a text, DIAdem uses 
Open as the dialog box heading.

FileDlgMultiSelect  Specifies whether you can select one or more files in the dialog box.

After you close the standard dialog box, the following DIAdem variables receive your settings:

ReturnValue DlgState type return value
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DlgState Receives the status of the dialog box after the user exits the dialog box:
"IDOk" when a dialog box closes with OK, 
"IDCancel" when a dialog box closes with Cancel.

FileDlgNameList Receives a list with the complete filename (path + name + filename 
extension) of the selected files.

File Selection Continued
By default you load and save files from/into the user folder. The following variables contain the 
current settings of these folders:

DataReadPath User folder for loading data

DataWritePath User folder for saving data

LayoutReadPath User folder for loading layouts

LayoutWritePath User folder for saving layouts

ScriptReadPath User folder for loading scripts

ScriptWritePath User folder for saving scripts

If you assign the folder specified in the file selection dialog box to one of the above-mentioned 
variables, you specify this folder as the new user folder.

Example DlgState = FileDlgShow("C:\Temp\","*.TDM")

If (DlgState = "IDOk") Then

  DataReadPath = FileNameSplit(FileDlgNameList(0),"P")
  Call DataFileLoad(FileDlgNameList(0))

Else

  Call MsgBoxDisp("Data loading has been aborted!")

End If

The example uses the standard dialog box for loading a DIAdem data set. If you click OK to close 
the dialog box, DIAdem uses the folder specified in the dialog box as the new data user folder and 
loads the data file that you want.

Selecting Multiple Files
The following statements open the standard File Selection dialog box where you can select 
several data files simultaneously.

Example Dim iLoop
DlgState = FileDlgShow("C:\Temp\", "My Files, *.*",_
                       "File Selection", True)
If (DlgState = "IDOk") then
  For iLoop = 0 to UBound(FileDlgNameList)
    Call MsgBox(FileDlgNameList(iLoop))
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  Next
End If

Use the FileDlgShow command to create a list of file names that you can use for serial evaluation.

Use the DirLstGet command if you want to use a script to automatically create a list of filenames. 
Refer to the DIAdem Help for detailed information about this command.

Displaying Messages
Dialog boxes are the only means of interacting with a script while the script is running. 

You can display messages to notify the user of an issue or to prompt a response. If you configure 
the message box in such a way that it has various confirmation buttons, the answer from the user 
can influence how the script is executed.

Displaying a Message in a Message Box

Syntax ReturnValue = MsgBoxDisp( MsgText, [MsgButtonType],
              [MsgType], [MsgStdButton], [MsgTimeOut],
              [MsgNotModal], [MsgNo])

MsgText Specifies a message text.

MsgButtonType Specifies the type and the number of buttons in a message box.
The parameter is only effective when you assign "MsgTypeNote" or 
"MsgTypeWarning" to the MsgType identifier.
Valid settings
"MB_Ok": OK
"MB_OkCancel": OK / Cancel
"MB_RetryCancel": Retry / Cancel
"MB_YesNo": Yes / No
"MB_YesNoCancel": Yes / No / Cancel
"MB_AbortRetryIgnore": Abort/Retry/Ignore
"MB_NoButton": No button

After you close the message box, the MsgState variable indicates which 
button you selected: "IDOk", "IDCancel", "IDRetry", "IDYes", 
"IDNo", "IDAbort", and "IDIgnore".
The setting MB_NoButton is only valid for non-modal message boxes 
(MsgType = "MsgTypeNote"), otherwise DIAdem automatically 
displays the OK button. If you close a box without using a button, the 
MsgState variable contains "IDNone".

MsgType Specifies the message box type.
"MsgTypeNote": General note
"MsgTypeError": Error
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"MsgTypeWarning": Warning
"MsgTypeInformation": Information
"MsgTypeAlert": Error
If you display an error message with "MsgTypeError", the script aborts.

MsgStdButton Specifies the default button of a message box.
0,1: first button (default setting)
2: second button
3: third button
If a message box has fewer buttons than specified here, DIAdem uses the 
default value zero. If this parameter is not specified, the default value is one.

MsgTimeOut Specifies how many seconds elapse before DIAdem closes a message box. 
The default setting of zero seconds means that the message box does not 
close automatically.

Note If you focus on another button in the message box, DIAdem does not 
automatically change the action assigned to the default button. To accept the settings in 
a message box in Windows applications, you click one of the buttons, or press the 
spacebar, <Esc>, or <Return>. If the timeout elapses without any action by the user, 
DIAdem returns the value of the default button (MsgStdButton) in the MsgState 
variable.

MsgNotModal Specifies whether DIAdem opens the message box in modal or non-modal 
mode.
0: modal opening means that DIAdem does not continue the script until the 
user closes the message box.
1: non-modal opening means that DIAdem continues the script without 
waiting for the user to close the message box. The MsgBoxCancel 
command closes the message box.

Note A MsgTypeWarning type message box ignores the MsgNotModal parameter 
and always opens the message box in modal mode. If you open a message box in 
non-modal mode, while a previous message box is on the screen, you delete the previous 
message.

MsgNo Specifies the number of a message text that is taken from an ATD file.
The type of message specifies the text group to be used in the file: Error 
messages access the Error text group, and all other messages access the 
Message text group.
In this case, the MsgText parameter is used as the insert text and is inserted 
into the message instead of the @1@ wildcard. However, the message text 
that is read from the file must contain this wildcard.

ReturnValue Receives the type of the button after the message box closes. The return 
value is a MsgState type.
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Note The messages can be accompanied by sounds. To assign sounds, select Control 
Panel»Sounds and Audio Devices from the Windows Start menu. Insert the wildcards 
@Click@ or @@Beep@@ into the message text. @@CRLF@@ outputs a line break. 
@@Variable@@ displays the contents of the DIAdem variable called Variable.

Examples Dim iVal

If (iVal = 0) Then
  Call MsgBoxDisp("Division by 0 not possible")
Else
  SmoothWidth = Trunc(ChnLength(2)/iVal)
  Call ChnSmooth(2,5,SmoothWidth,"maxNumber")
End If

If the iVal variable has the value 0, DIAdem cannot calculate the smoothing width to be used and 
a message appears.

Call MsgBoxDisp("Calculate statistic?","MB_YesNo")

If MsgState = "IDYes" Then
  Call Statistic
End If

The Yes and No buttons specify how the script continues.

Dim Txt
Txt= "Please select a range and @@CRLF@@"
Txt= Txt & "confirm it with >End Interaction<"

Call MsgBoxDisp(Txt,"MB_NoButton",,,0,1)

Call InteractionOn()
Call MSgBoxCancel()

With these statements, you display a non-modal information box without buttons. The 
MsgBoxCancel command closes the message box.

Specifying the Button Assignment
Use the MsgButtonTextSet command to label the buttons in the next message box.

The MsgBoxDisp command deletes the previous button labels. Later messages have the original 
text. Therefore use the commands MsgBoxTextSet and MsgBoxDisp consecutively, for free 
labels.

Syntax MsgButtonTextSet(MsgButtonText1 [,MsgButtonText2]
                [,MsgButtonText3])

[MsgButtonText1] Specifies the text of the first button label.
Replaces OK in "MB_OK" and "MB_OKCancel", retry in 
"MB_RetryCancel", Yes in "MB_YesNo" and "MB_YesNoCancel"  
and Abort in "MB_AbortRetryIgnore".
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[MsgButtonText2] Specifies the text of the second button label.
Replaces Cancel in "MB_OkCancel" and "MB_RetryCancel", No in 
"MB_YesNo" and "MB_YesNoCancel", and replaces Retry in 
"MB_AbortRetryIgnore".

[MsgButtonText3] Specifies the text of the third button label.
Replaces Cancel in "MB_YesNoCancel" and Ignore in 
"MB_AbortRetryIgnore".

Example Call MsgButtonTextSet("Totals","Extreme values")

Call MsgBoxDisp("Calculate statistical values?",_
                "MB_YesNoCancel")

If (MsgState <> "IDCancel") Then

Dim iLoop
  For iLoop= 1 To 23
    StatSel(iLoop)= "No"
  Next

  If (MsgState = "IDYes") Then
    StatSel(2)= "Yes"
    StatSel(3)= "Yes"
  Else
    StatSel(4)= "Yes"
    StatSel(5)= "Yes"
  End If

  Call StatCalc(2)

End If

This example opens a message box for displaying a text. The MB_YesNoCancel parameter 
displays the Yes, No, and Cancel buttons. The MsgState variable receives one of the three 
options. It can accept "IDYes", "IDNo" or "IDAbort" as a response.

MsgButtonTextSet replaces the labels of the Yes and No buttons with the labels Totals and 
Extreme values. The type of button, or response, remains unchanged.

Positioning / Scaling a Message Box
The following command specifies the size and position of the next message box that the 
MsgBoxDisp command displays. 

The MsgBoxDisp command deletes the previous position specification. Subsequent messages 
appear in the center of the screen. For this reason, when you enter positions, use the commands 
MsgBoxSetPos and MsgBoxDisp in that order.

Syntax MsgBoxSetPos(MsgBoxXPos, MsgBoxYPos, MsgBoxWidth,
             MsgBoxHeight)

MsgBoxXPos Specifies the position of the left edge of the message box as a percentage of 
the screen width.

Sa
m

pl
e



Lesson 5 Variables and Commands in Scripts

5-18 | ni.com

MsgBoxYPos Specifies the position of the top edge of the message box as a percentage of 
the screen height.

MsgBoxWidth Specifies the width of the message box as a percentage of the screen width.

MsgBoxHeight Specifies the height of the message box as a percentage of the screen height.

Example Call MsgBoxSetPos(10,10)

Call MsgBoxDisp("Please select a range",,,,3)

The message box appears in the top left corner of the window.

Displaying a Message in the Status Bar
The following type of message display is only necessary when you suppress DIAdem standard 
messages with the AutoEcho="No" button.

Syntax MsgLineDisp(MsgText)

MsgText Specifies the message text to be displayed.

Example AutoEcho = "No"
Call DataFileLoad(DataFileName)
Call MsgLineDisp("Testing validation of "&DataFileName)

In the status bar the message displays the name of the file that is to be evaluated.

You can practice the topics of this lesson by working through Exercise 5-1.

Interrupting a Script
You may have to interrupt the script, for example, to display a report.

Interrupting the Script until a Key is Pressed
Syntax KeyWait

This command stops the script until the user presses any key except <Esc>.  The status bar displays 
the prompt Please press a key to continue the script.

Interrupting the Script for a Period of Time
Syntax Pause(PauseDuration)

PauseDuration Specifies for how many seconds the script is interrupted.Sa
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This command interrupts the script for the specified period. The status bar displays the remaining 
time. The user can end the interruption by pressing a key.

Interrupting the Script for Interaction
Syntax InteractionOn([InteractionText])

InteractionText Specifies the text that DIAdem displays, when interaction is enabled, in a 
non-modal dialog box.

This command stops the script at any point and at the same time enables a mode in which you can 
still operate DIAdem. When you transfer a text, DIAdem displays this text in a non-modal dialog 
box. When you end the interaction mode, the script continues.

Click End Interaction to end the interaction mode.

The following points indicate that the interaction mode is enabled:

• The menu item End Interaction is enabled in the File menu.

• The toolbar button for ending interaction is enabled.

• The status bar displays an appropriate interaction symbol.

During interaction, you can start other scripts that, in turn, also enable interaction. The File menu 
displays the current number of enabled interactions (interaction stack) next to End Interaction.

If an error occurs during a script or if you stop the script manually, DIAdem ends the entire 
interaction stack. DIAdem does not continue interrupted scripts.

You cannot close DIAdem in the interaction mode.

In the interaction mode, you can edit scripts, but you cannot record them.

You can practice the topics of this lesson by working through Exercise 5-2.
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Structuring Scripts
If a script is too extensive and complex, you can group parts of the task into subscripts. Subscripts 
increase clarity and facilitate the reuse of partial solutions.

Calling Subscripts
Syntax ScriptStart(FileDlgName[,VBSProcName])

This command calls the FileDlgName subscript from the running script. When the subscript is 
called, DIAdem first executes the main section of the subscript. DIAdem then executes the 
procedure that is specified by VBSProcName.

You also use this command to execute a script directly after DIAdem launches. Refer to the 
Launching DIAdem with Parameters section in Lesson 8, Customizing DIAdem, for more 
information.

Note When the ScriptStart command is called, you cannot debug the procedures, 
transfer parameters, or access script variables. You can use only DIAdem variables or 
user variables to transfer values.

Syntax ScriptInclude(ScriptFile)

To integrate one script into another script, this command runs the initializations in the main part of 
the subscript and declares all the global variables, procedures, and functions of the subscript to the 
main script. Then you can access these variables, procedures, and functions in the main script.

Call the ScriptInclude command only once, at the beginning of the script. Do not use the 
ScriptInclude command in loops.

Labeling Subscripts

Syntax Subsequence([SubsequenceText])

Use this keyword at the beginning of a script to indicate that the script is a subscript. You cannot 
execute the subscript by itself and a subscript without a main script makes no sense. If you try to 
start this kind of subscript, the following message appears: "The 'Subsequence' subscript 
cannot start" and the action will abort

You can use Subsequence Text to add text with a maximum of 255 characters to the message.

You must use the commands ScriptStart or ScriptInclude to start scripts labeled 
Subsequence from another script.

You can practice the topics of this lesson by working through Exercise 5-3.Sa
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Working with Files and Folders
This is a selection of commands for working with files and folders. For the complete list, enter 
File handling in the DIAdem Help Index.

TextFileOpen(FileName,Mode)

Opens or creates a text file. FileName contains the path, the name, and the filename extension 
of the text file. Use Mode to specify the attributes DIAdem opens the file with: read, write, 
generate, code, and access rights.
This function returns a file handle you use to access the text file.

TextFileClose(TextFileHandle)

Closes a text file.

TextFileEOF(TextFileHandle)

Checks whether DIAdem has reached the end of the text file.

TextFileSeek(TextFileHandle,LineNo)

Jumps to a specific line in a text file.

TextFileWriteLn(TextFileHandle,Text)

Writes a text line into a text file. 

TextFileReadLn(TextFileHandle)

Reads a line from a text file. You use the TextFileSeek function to specify the line.

TextFileError(FileHandle)

Displays the number of the error that occurred the last time the file was accessed.

TextFileErrorTxT(FileHandle)

Displays the error that occurred the last time the file was accessed.

FileExist(FileName)

Checks whether the FileName file exists. Enter the name of the file with the complete path 
and extension, and enclose it in quotation marks. If you do not enter the path, the command 
checks whether the file exists in the current folder.

FileRename(FSSourceName,FsTagetName)

Renames the FSSourceName file.

FolderExist(FSSourceName)

Checks whether the specified folder FSSourceName exists.Sa
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FolderCreate(FSSourceName)

Generates a new folder called FSSourceName.

FileNameSplit(Text,Type)

Splits a filename according to the path ("P"), the filename ("N"), or the extension ("E").

PathDlgShow(PathTitle,InputPath)

Displays the standard dialog box for path selection. PathTitle specifies the dialog box 
heading. InputPath specifies the default folder.

DataFileDelete(FSSourceName)

Deletes the .tdm, .tdms, or .dat type file FSSourceName and the associated binary file, 
which contains the mass data.

DataFileCopy(FSSourceName,FSTargetName)

Copies the .tdm, .tdms, or .dat type file FSSourceName and the associated binary file, 
which contains the mass data.

DataFileRename(FSSourceName,FSTargetName)

Renames the .tdm, .tdms, or .dat type file FSSourceName and the associated binary file, 
which contains the mass data.

The following example opens the text file Test.txt, jumps to the tenth row, and reads the file 
linewise to the end. The example then displays the read text in a message box. If an error occurs, 
the example displays the error number and error text.

Example Dim iFileHandle, iGotoLine, iError, sText
iFileHandle = TextFileOpen("c:\Test.txt", tfRead)
If (iFileHandle <> 0) Then
  iGotoLine = 10
  iError = TextFileSeek(iFileHandle,iGotoLine)
  If (iError = iGotoLine) Then
    sText = ""
    Do While Not TextFileEOF(iFileHandle)
      sText = sText & TextFilereadLn(iFileHandle)&vbCRLF
    Loop
    Call MsgBoxDisp(sText)
  End If

Else
  Call MsgBoxDisp("Error number: "&_
                  TextFileError(iFileHandle)& vbCrLF &_
                  "Error message: "&_
                  TextFileErrorTxt(iFileHandle))
End IfSa
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Working with Applications
Exiting DIAdem
Use the following command if you want to exit DIAdem with a script:

Syntax ProgramExit

Together with the FileModification variable that determines the program behavior when the 
parameters are not specified, DIAdem prompts the user to save non-saved files.

Starting an External Program
Use the following command to start an external program via a script. DIAdem continues the calling 
script and does not wait for the external program to execute.

Syntax ExtProgram(ExtProgramName, ExtProgramArg)

ExtProgramName Specifies the name of the external program and the path.

ExtProgramArg Specifies the parameters that DIAdem uses to start the program. If you do 
not specify a program name and the ExtProgramArg parameter contains a 
filename with a filename extension, DIAdem tries to start the program 
linked to this file.

Example Call ExtProgram("","C:\test.doc")

The example starts the program linked to the filename extension .doc, which is usually Microsoft 
Word.

D. Defining and Using User Commands

In DIAdem you can add your own commands or redefine existing commands. In scripts, you define 
user commands as procedures or functions.

The procedures and functions consist of a series of statements enclosed in the keywords Sub and 
End Sub, or Function and End Function. Both of these types can include arguments, but only 
the functions can return values. The Procedures section in Lesson 2, The VBS Functionality 
explains the difference between a procedure and a function.

When you have defined the user commands, save the script, select Settings»Options»Extensions»
User Commands», and click Add to register the script, as shown in Figure 5-3. When you register 
the script, DIAdem enables the user commands file and provides the user commands defined in the 
script. Sa
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Figure 5-3.  Registering User Commands

You can store user command files in the desktop file and reuse your user commands in any 
DIAdem session that accesses the desktop file.

Note If you use an external script editor to modify a registered script, you must reload 
the script by selecting Settings»Options»Extensions»User Commands and clicking 
Refresh. The DIAdem script editor refreshes the script automatically when the script 
editor saves the script.

You can use user commands at the following points in DIAdem:

• In VBS scripts

You can call the names of procedures and functions that are defined as user commands in any 
script. You do not need to enable the script or a script reference.

• In DIAdem REPORT and DIAdem VIEW

You can use user commands where you format text or numbers, for example, when you format 
an axis text. DIAdem only recognizes a command that a script defines as a user command if 
the command is enclosed in two leading and two trailing @ characters, for example, 
@@MyFunc@@.

Use the following variables to define a user command for displaying table values or axis labels:

CurrFormatValue Abbreviated to CFV, contains the current number to be formatted.

CurrAxisNo Abbreviated to CAxN, contains the current axis number.

CurrChnNo Abbreviated to CCN, contains the current channel number.

CurrChnIdx Abbreviated to CCI, contains the current channel index.

CurrGroupIdx Abbreviated to CGI, contains the current group index.

CurrValIdx Abbreviated to CVI, contains the current value index.
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A formatting call might look like this: @@MyFunc(CurrFormatValue)@@

In the layout parameters, you can also enter user commands that DIAdem runs before or after 
it refreshes the report. The @ character is not necessary.

• In the Calculator

You can access functions defined as user commands wherever you use formulas. The 
ScriptEvaluate function calls a user command. This function returns text that the user 
command specifies, for example:

T1 = ScriptEvaluate(MyFunc(123))

When you define and use user commands, remember the following points:

• If you use user commands in scripts, the user command called cannot use functions, 
procedures, or VBS variables of the calling script. However, the calling script can use every 
registered user command.

• When the name of the user command is the same as the name of a DIAdem command, the user 
command replaces the DIAdem functionality. You must then use Diadem.Commandname to 
call the original DIAdem command.

• If you use a user command to format text with @@ syntax, the user command must have a return 
value. That means you must define the command as a Function. You cannot define the 
command as Sub. Every other expression that uses @@ syntax must also have a return value. 
You can use variables or formula expressions.

• You can call user commands recursively.

• You can define global variables in a user command file. Declare the variables in the global area 
outside the function.

• You can also define classes in a user command file. A class is the formal definition of an object. 
Refer to the Working with Objects section in Lesson 9, Advanced Script Options, for more 
information about objects. 

• You cannot abort a user command by pressing the <Esc> key. To test a user command, start the 
procedure as a script in the DIAdem SCRIPT panel.

Working with User Commands
You must select Settings»Options»Extensions»User Commands»Add to register a user 
command file and use the user commands contained in this file.

If you want to use user commands in a project, without registering the user command file in the 
general settings, use the following commands.

To register a script that contains user commands use the following command:

Syntax ScriptCmdAdd("ScriptFile")

ScriptFile Specifies the script name.
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To remove a script that contains user commands use the following command:

Syntax ScriptCmdRemove("ScriptFile")

ScriptFile Specifies the script name.

You cannot use the commands defined in this script later in DIAdem. Use the ScriptCmdRemove 
command only at the end of the script that calls the user commands.

Use the next command to restart the script engine. DIAdem deletes all global variables and user 
commands.

Syntax ScriptCmdReset

You can practice the topics of this lesson by working through Exercise 5-4.
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Summary
• DIAdem differentiates between program variables that are connected with a function, freely 

assignable auxiliary variables, and user-defined variables.

• The DIAdem Help lists all available DIAdem variables and commands in alphabetical order.

• Use the GlobalDim command to declare global variables.

• The FileDlgShow command opens the standard dialog box for selecting files. The DlgState 
variable shows how the dialog box was closed.

• You can use the MsgBoxDisp command to display a note, a warning, or a user decision in a 
message box. The MsgState variable notes which button the user clicked to close the message 
box.

• You interrupt a script for a specified time with the Pause command, and with the KeyWait 
command the interruption continues until you press a key. The InterActionOn command 
interrupts the script and switches DIAdem into an operational mode.

• The command ScriptInclude integrates a subscript into the running script.

• User commands increase the range of DIAdem functions. In VBS scripts, you define user 
commands as procedures or functions. To register the user command, you then select Settings»
Options»Extensions»User Commands.

You enter the name of a user command to call the command.

The ScriptEvaluate function in the Calculator calls user functions. DIAdem only 
recognizes a user command call in DIAdem REPORT if the command is enclosed in two 
leading and two trailing @ characters, for example, @@MyFunc@@.
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